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Introduction

1 Introduction

This User Manual will show you how to install the GNU Toolchain and Eclipse, how to compile and
debug a simple example using the Ronetix Evaluation board EB9261 with an Atmel AT91SAM9261
and PEEDI JTAG Emulator and Flash Programmer.

The necessary software components for an ARM cross development are:

- GNU toolchain (compiler, linker, gdb)
- Eclipse IDE including Zylin CDT Plug-in for C/C++ development
- Java Runtime

To enable a quick start in the ARM cross development Ronetix provides pre-built packages for Linux

and Windows hosts.

The necessary files for a Linux host are:
- The GNU toolchain:
http://download.ronetix.info/toolchains/arm/ronetix-gnutools-arm-elf-4.1.1-linux.tar.bz2

- The Eclipse IDE: http://download.ronetix.info/eclipse/eclipse.tar.bz2

- A simple example:http://download.ronetix.info/examples/at91sam9261 example mmu.tar.gz

The necessary file for a Windows host is:
http://download.ronetix.info/toolchains/arm/ronetix-toolset-arm.exe
This is a Windows installer which installs the GNU toolchain, Eclipse IDE + Zylin CDT and Java.
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Installation on Linux

2 PEEDI JTAG Emulator Installation

PEEDI (Powerful Embedded Ethernet Debug Interface) is an EmbeddedICE solution that enables you
to debug software running on ARM processor cores via the JTAG port.

In order to debug you need to configure PEEDI JTAG Emulator. The configuration of PEEDI is
common for both toolchains for Linux and Windows.

You can find detailed information about PEEDI in the PEEDI’s User Manual:
http://download.ronetix.info/peedi/doc/peedi rev.A manual.pdf

- Connect PEEDI to a free port of your LAN switch/hub using the supplied UTP patch cable.
- Connect PEEDI to the target using a JTAG cable and if needs the one of the supplied JTAG
adapters. The JTAG adapter must be on the PEEDI side of the JTAG cable:

Adapter JTAG cable

Target
! S
[

- Connect PEEDI to a COM port of your PC using the RS232 cable. Start any kind of terminal
emulation program (HyperTerminal) and set it to 115200 bauds, 8 data bits, no parity and no
flow control.

- Restart PEEDI holding pressed both front panel buttons to enter RedBoot command line.
- Use fconfig command to set the network configuration and other parameters.

WARNING:
If PEEDI is set to get its network settings from a DHCP server and if the Ethernet cable is
unplugged or there is no DHCP server on the Ethernet, it may take some time for PEEDI to
boot. To avoid this, make sure PEEDI can reach a DHCP server or assign a static IP address.

- Restart PEEDI again for the changes to take effect

After PEEDI is up and running (this should take some seconds after reset), press and hold the
green front panel button and PEEDI will start to display its IP address on the display.

Connect to PEEDI with telnet application using the IP address from the previous statement. If
connected, you should see the PEEDI CLI prompt

ARM cross development 6 www.ronetix.at



Installation on Linux

3 Toolset installation on Linux

To install the pre-built from Ronetix GNU cross-development tools:

Download the GNU tools form here:
http://download.ronetix.info/toolchains/arm/ronetix-gnutools-arm-elf-4.1.1-linux.tar.bz2

or get it from the CD.

Uncompress the archive

cd /
tar xvfj ronetix-gnutools-arm-elf-4.1.1-Tinux.tar.bz?2

The toolchain will be installed in the /usr/cross/arm directory. If want to install the toolset in another

directory make sure you have a symbolic link in the /usr/cross

1. Set a path to the /usr/cross/arm/bin: in the .bashrc file add the following:

export PATH=$PATH:/usr/cross/arm/bin

2. Test the toolchain installation:

[Tinbox]$ arm-elf-gcc -v

Using built-in specs.

Target: arm-elf

Configured with: /home/src/cross/gcc-4.1.1/configure --target=arm-elf -
-build 7686-pc-Tinux-gnu --host 1686-pc-1inux-gnu --disable-nils --with-
float=soft --prefix=/usr/cross/arm-elf --enable-interwork --enable-
multilib --enable-languages=c,c++ --with-newlib --enable-win32-
registry=ronetix-arm --with-gnu-as --with-gnu-1d --with-
headers=/home/src/cross/newlib-1.14.0/newlib/1ibc/include

Thread model: single

gcc version 4.1.1

3. Installing Eclipse IDE

Download the Eclipse IDE from here or get it form the CD:
http://download.ronetix.info/eclipse/eclipse.tar.bz2
The file eclipse.tar.bz2 includes:

- Eclipse SDK v3.2.1

- Embedded CDT v3.1 patched by Zylin

- Zylin plugin

- Java Virtual Machine v1.5.0_09

cd /usr/local
tar xvfj eclipse.tar.bz2

Set a path to the /usr/local/eclipse: in the .bashrc file add the following:

export PATH=$PATH:/usr/local/eclipse

4. Installing an example

Download the EB9261 example from here:
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http://download.ronetix.info/examples/at91sam9261 example mmu.tar.gz

or get it from the CD.

C

mkdir work

cd work

tar xvfz at91sam9261_example_MMU.tar.gz

At this point you should be able to build, debug and run applications on embedded ARM targets.
You can compile and debug the example manual, from the shell prompt or using Eclipse. The working
with Eclipse is explained in “Section 5: Working with Eclipse” from this manual.

5. Compiling from the shell

Cd at91sam9261

[Tinbox]$ make

arm-elf-gcc -x assembler-with-cpp -c -mcpu=arm9 -g -gdwarf-2 -wa, -
amhls=src/cstartup. st src/cstartup.S -o src/cstartup.o

arm-elf-gcc -c -mcpu=arm9 -00 -gdwarf-2 -mthumb-interwork -fomit-frame-
pointer -wall -wstrict-prototypes -fverbose-asm -wa,-ahlms=src/init. st
-MD -MP -MF .dep/init.o.d -I . -I./inc src/init.c -o src/init.o
arm-elf-gcc -c -mcpu=arm9 -00 -gdwarf-2 -mthumb-interwork -fomit-frame-
pointer -wall -wstrict-prototypes -fverbose-asm -wa,-ahlms=src/main.Ist
-MD -MP -MF .dep/main.o.d -I . -I./inc src/main.c -o src/main.o
arm-elf-gcc -c -mcpu=arm9 -00 -gdwarf-2 -mthumb-interwork -fomit-frame-
pointer -wall -wstrict-prototypes -fverbose-asm -wa, -
ahlms=src/dhry_1.1st -MD -MP -MF .dep/dhry_1.0.d -1 . -I./7nc
src/dhry_1.c -o src/dhry_1.o0

arm-elf-gcc -c -mcpu=arm9 -00 -gdwarf-2 -mthumb-interwork -fomit-frame-
pointer -wall -wstrict-prototypes -fverbose-asm -wa,-
ahlms=src/dhry_2.1st -MD -MP -MF .dep/dhry_2.0.d -1 . -I./7nc
src/dhry_2.c -o src/dhry_2.o

arm-elf-gcc -c -mcpu=arm9 -00 -gdwarf-2 -mthumb-interwork -fomit-frame-
pointer -wall -wstrict-prototypes -fverbose-asm -wa,-ahlms=src/mmu. ISt
-MD -MP -MF .dep/mmu.o.d -I . -I./inc src/mmu.c -o Src/mmu.o
arm-elf-gcc ./src/cstartup.o ./src/init.o ./src/main.o ./src/dhry_1.o0
./src/dhry_ 2.0 ./src/mmu.o -mcpu=arm9 -nostartfiles -
T./prj/AT91SAM9261. 1d -Wl1, -Map=BasicMMU.map, --cref, --no-warn-mismatch
-0 BasicMmu.elf

arm-elf-objcopy -0 Thex BasicMMU.elf BasicMMU.hex

6. Debugging

To simplify the debugging there is a file ‘. gdbinit "' in the project directory which is read when you
run gdb/insight. Adjust the ‘~/work/at91sam9261/.gdbinit’ to match the IP address of PEEDI.
From a X-console start the Insight debugger:

[Tinbox] arm-elf-insight BasicMMU.elf
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main.c - Source Window E”EE

File FRun ¥iew Control Preferences Help

FMPHD B SEAESMIE Find:l—’ o
rin.c RI 5o ] SowRcE v

128 int main(void) 2
- 129 ¢
- 130 vold (*pDhrystone) (wvoid) = (woid (*) (woid)) (f{unsigned int) ATI1F Dk
- 131 ATA1F DEGU Printk("-I- Enter in main() sectionnhsc");
132
- 133 ATIIF DEBCGU Printk("-I- no MMU, I+D Caches Disabledwn'rc");

- 134 ATYIF DisahlelCache () ;
- 13k ATI1F DisablelCache () ;

- 136 ATIIF Dhrystone () =
137
- 138 ATIIF_DEGU_Printk ("‘nir-I- no MMU, I Cache Enabledin’r"); F
I~ | =
IF'ngram stopped at line 130 20000430 130
I

The following descriptions discuss the use of the default debugger toolbar buttons.

The Run button, do not use this button. Instead of this use the “Continue” button

il

@ During the debugging process, the Run button turns into the Stop button to interrupt the
— debugging.

) The Continue button continues execution until a breakpoint, watchpoint or exception is

encountered, or until execution completes.
r{-q,} The Step button steps to next executable line of source code. Also, the Step button steps

into called functions.

T The Next button steps to the next executable line of source code in the current file. Unlike
- the Step button, the Next button steps over called functions.

{riq, The Finish button finishes execution of a current frame. If clicked while in a function, it

finishes the function and returns to the line that called the function.

Download Performance

By default, GDB versions previous than v6.5.50 (from 06.08.2006) download program code and data
in small packets that are not necessarily a multiple of four bytes in length. This causes program
download times to be slower than necessary, especially with ARM targets. There are two GDB internal
variables that affect this. To improve GDB download performance, you should set the download write
size to a binary value 16KB and the memory write packet size to a larger value to allow for packet
overhead (+100 bytes is plenty). For example, to download 16KB at a time:

(gdb) set remote memory-write-packet-size fixed
(gdb) set remote memory-write-packet-size 16384
(gdb) set download-write-size 16128
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Note:
No error is returned to GDB in case of an invalid 4 byte memory read access auring
0 a period defined by GDB_READ _INGNORE_TIME in the target configuration
file. This is because GDB refuses to connect to the target If it gets an error during
this connection sequence. GDB tries to read the stack frame during the connection

sequence and this may lead to invalid memory access.

ARM cross development 10 www.ronetix.at



Installation on Windows

4 Toolset installation on Windows

Please download the GNU toolchain installer from our web site, launch it and follow the instructions.
http://download.ronetix.info/toolchains/arm/ronetix-toolset-arm.exe

The setup will install:

By default, the installer provided by Ronetix installs everything necessary for developing. This
includes:

e arm-elf GNU tools (compiler, linker, and debugger)

e Eclipse IDE v3.2.1 and Zylin CDT plug-in

e Java run-time environment for the Eclipse

e ready-to-build examples

e afree TFTP server
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5 Working with Eclipse

5.1 Adding a project

Eclipse (http://www.eclipse.org) is an open-source, Java based, powerful Integrated Development
Environment (IDE). Adding the CDT plug-in (C/C++ Development Toolkit), you can edit and build C
programs using the GNU compiler toolkit. A detailed C/C++ Development User Guide for Eclipse can
be downloaded from http://www.eclipse.org/cdt or from the Ronetix site.

The Java run-time environment, Eclipse and the CDT plug-in are installed by the installer from
Ronetix. Now start Eclipse IDE using the desktop icon, the “Workspace Launcher” dialog should
appear, where you need to point the workspace folder. In our case point “C:\Program
Files\Ronetix\examples\at91sam9261\pm9261”, this way eclipse will automatically include the project
files when we create a new project. Next click OK.

&= Workspace Launcher |

Select a workspace

Eclipse 50K stores wour projects in a folder called a workspace.,
Choose a workspace Folder to use For this session,

P ==t K | Program Files\Fonet nplesiatol samoze6 1\ pmdz6 1 Browse, ., |

[™ Use this as the default and do not ask again

(a]4 I Zancel

Now click at the "Workbench" icon at the right edge of the window.
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Working with Eclipse

& Java - Eclipse SDK o ]|
File Edit Mavigate Search Project Run  Window Help

ol x|
File Edit Source Refactor Mawigate 3Search Project Run Window Help
[ it % -0-%- | EHEG-|®&|E-|-5-0 0 -0 T | 8'2ava
£ Pack ::- h Hierarchy| = = = O|[ 5= outline £2 = =
|| <‘:===> =4 An outline is not available,
r_z_\ Prablems &3 Javadoc|DecIaration| }:D T
0 errors, 0 warnings, 0 infos
Description 4 | Resource | Path Location |
| o | [[aT0 = ® &

Now you need to add as projects the pm9261 example. Click File->New->Project. In the New Project
dialog select Standard Make C Project and click Next:
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Working with Eclipse

& Mew Project

Ed
Select a wizard

Create a new C Project which uses a simple makefile

Wizards:

| bype filker kext

----- @ Java Project

& Java Project from Existing Ant Buildfile

l_rﬁ Plug-in Project

-[= General
H& C

@ Managed Make C Project
: Standard Make C Project (I
E-= Gt
- VS

= Back I Mexk = I Finish

Zancel

In the “New Project” dialog put “BasicMMU?” for project name and click Finish. The BasicMMU already
exists there so all of its files will be automatically imported in the new created Eclipse project.

& MNew Project

ﬁ x|
C/Make Project

Create a Mew  Project using 'make’ to build it

Project name: | BasichML

W Use default location

LLocation: | Z:/Program Files)Ronetixexamples/ak9l sam9261 /pm3261 jBasickMMU Ea

Browse, ., |

= Back

Mext = | Finish I Cancel

Now Eclipse will ask you to change the perspective to C/C++, check remember my decision and click
YES:

ARM cross development
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Working with Eclipse

& Open Associated Perspective?

This kind of project is associated with the C/C++ perspective. Do wou wank
ko open this perspective now?

¥ Remember my decision

X

Now the Eclipse window should look like:

& C/C++ - Eclipse SDK
File Edit Refactor MNavigate Search Project Run  Window Help

=0l x|

[ wi= Gl e fadainea caa [ sty Bl G e BO78 Rieic | a e A Ein | Bgjcss &loava
Fg cfct+... 33 Nawga...| = = = 0|8z 0. 2 M... ‘ = =
- | =T An outline is not avalable,
28 :f’ BasichU
[M\Ennsole ‘ Properties‘ }:9 =
0 errars, 1 warning, 0 infos
Description  # | Resource | Fath | Location |
= % warnings (1 item)
% Error launching external scanner info generator (gee -E -P -y -d| BasicMMU Unknown
| o | |[alo=®
Use the "Project” menu and remove the checkmark at "Build Automatically™:
www.ronetix.at
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Working with Eclipse

& C/C++ - Eclipse SDK

File Edit Refactor Mavigate Search | Project Run Window  Help

IC3- | | % -] @
KE|'C.I"C++... &3 Naviga...| =8|
|3 &

[#-4=5 BasicMMU

Open Project
Clmse Projeck:

b- e

|arg Build Al
fckive Build Configuration
Clean Selected Filels)
Build Selecked Eilels)
Build Project
Build Morking Set
Clean. ..

Ctrl+-B

Create Make Target, .,
Eiuild MMake Target, ..

Broperties

Open main.c by double clicking on it in the BasicMMUY/src folder:

& (/C++ - main.c - Eclipse SDK

_|ol x|
File Edit Refactor Mavigate Search Project Run | Window Help
& | % - | -8~ [d-6- |3#~-0-Q%-|® 5 |=- i | EEcice+  %Debug
: aJJava
[ €] main.c B2 = B[ 5= outline 52 Make ... | =0
int wain(roid) - BV o7
{ ...... ﬂ stdiolh

B4 BasichMU

roid (*pDhrystone) (void) =

{void (%) (void)]

<> Binaries : : ? } = arorsamazet b
B-G inc AT91F _DEGU Printk("-I- Enter in mainf(] sect . lib_ATO154MIZ61 b
2 T | | S | b
i ATS1F DEGU Printk("-I- no MMU, I+D Caches I || | B T NTRIESINUM
[].__@ dhirv.h AT91F DisablelCache(): =i ;rray .
[]___IE fib_armazéei_s.h AT91F DisableDCache(); o AT91F_DEGL Printk
[]___IE b AT91F Dhrystone(); £ testioop
[]...@ cskartup. 5 . PO | ® AT9IF_Dhrystane
-2 dhry_t.c AT91F_DBGU Printk{™ynir-I- no MMU, I Cache || | ©  ATOLF InitMMU
AT91F EnasbleICache(); .
B[] dhry_2.c _Enebleltachey: 1 Wl . ® man
[]___@ Rite AT91F Dhrystone():
o Lo . |
[]___@ e ATO1F InitMMU(tth_array);
I:I--- cstartup.o - [armle]
[]__ dhiry_1.0 - [armls] ATQlF_DBGU_Print,k("\ nyr-I- MMU & I Cache Ei
- dhry_2lo - [armls] AT91F EnableICache():
= rit. o - [armle] pDhhrystone () ; // call the functic
[+ main.o - [armle] . | = =
&3] mmu.o - [armle]
cstartup. st Problems | Bl Console 2 Propetties B | w2 T =
&
dhry_1.lst BasicMMU [Embedded debug (Mative)] C:\Program Files\Ronetixlexamplesiat9lsam9261\pmI261 \BasicMMUBasictU. elf {06-1
] dhry_2. st
init.lst
] main. st
~[&] . lst
[]---3‘@ BasichMU.elf - [armlz]
- BasicMMU. hex —
e BasicMMLU. map
A remlemFil- LI il

=)

i

J f" JBasichMU srefmain.c

I[alo@E® ;|

Now build the project:

ARM cross development
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& C/C++ - Eclipse SDK
File Edit Refactor Mavigabe Search | Project Run Window Help

| it

T, C/C++ Projects

| |- | @

Open Project
Close Project

L- s

fg Incl
= inc

EHz pri

E|[E; i

=

®

- @ cskark

- [H] ATS15AMIZELR
- [h] b_AT915AMIZ61.h

|= AT915AMIZE1,Id

@ rnrnu. b

ava Build All
Active Build Configuration
Zlean Selected File(sy
Build Selected Eilels)
Build Project

Chrl+E

Build Warking Set
Clean. ..
Build Automatically

- [0 dhrw.h

Create Make Target. ..
Build Make Target...

@ lib_arm9zéej_s.h

Properties

up.S

At this point your project should be compiled and liked to a single executable “BasicMMU.elf” file. You

can check its presence.

5.2 Configuring and working with the Eclipse built-in debugger

First click the arrow right to the “bug” button and next “Debug...”

Project

- 5% -

Fun  Window Help
&

EE-\

-

—

&

"G B0 | &Y |2

Debug As L4

% Debug,..

Organize Favorites. ..

This opens the Debug configuration dialog. Select Embedded debug (Native) and click the New

button:

ARM cross development
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Create, manage, and run configurations

9 | B 2 -

I tvpe filker bext

----- [ CC++ Attach to Local Apy
----- E Z/iZ++ Local Application
----- ] C/C++ Pastmartem debug
----- & Eclipse Application

-3 Embedded debug {Cywguwin
Embedded debug (Mative)
----- 4% Equinosx ©5Gi Framewoark,
----- =] 1ava applet

----- 3] Java Application

----- Ju JUnit

----- JU Junit Plug-in Test

1 | H

----- E Remote Java Application
----- Ba] swT Application

Canfiqure launch settings From this dialog:
“ - Press the 'Mew' butkon ba create a configuration of the selecked bype,
:=| - Press the 'Duplicate’ button to copy the selected configuration.
# - Press the 'Delete’ butkon to remove the selected configuration,
:{——:D - Press the 'Filker' butkon to configure Filkering options,
- Edit or view an existing configuration by selecting it.

Caonfiqure launch perspective settings From the Perspectives preference
page,

Debug I Close

This will change the look of the window to:

Create, manage, and run configurations

L

=

| kyvpe filker kext

[E] C/C++ Attach to Local Ap
E Z/iC++ Local Application
E C/iC++ Postrorkem debur
----- 4 Eclipse Application

5 Embedded debug {Cywguwir
- Embedded debug (Mative,

----- 4 Equino: 053G Framewark,
----- Bl 1awea annlek ha

56 [—

| 3

#;f& Del:uugger‘ [ | Cummands| Eiy Suurce| ] Comman |\

Marme: | BasicMML

Project:

I EasicMMU Browse. .. |

CiC++ Application:

IBasicMMLI.eIF SEarchPrDject...l Browse, .. |

Apply | Revert |

Debug I Close |

If your window does not look like the previous, follow the next two steps:

ARM cross development

18 www.ronetix.at



Working with Eclipse

1. Enter BasicMMU for name and click Project Browse to select the BasicMMU and click OK:

& Project Selection

Zhoose a project to constrain the search for a program

=10l x|

=% BasicMMU

o]

Cancel

2 .Next enter BasicMMU.elf for C/C++ Application.

Create, manage, and run configurations

B
L

=

i

| bype filker kext

----- E C}iZ++ Local Application
""" E ZJC++ Postmortem det
""" 4 Edlipse &pplication

----- G Embedded debug (Cyg
=5 Embedded debug (Mati:
- 56 Mew_configuration

----- [€] CjC++ Attach to Local

----- 'ii Equinoe O5Gi Framewo
..... Bl Tzwa Annlak -
| r

Mame: | EasicrMMU

f‘.\i Debugger | B Commands | Fy Source | ] Comman |

Project:

| BasichmL
C/iC++ Application:

| BasichML. elf

Browse. .. |

SearcljF‘ru:uject...l Browse, ., |

Apply | Rewvert |

Debug I Close

ARM cross development
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Now select the Debugger tab and Browse to locate “...\Ronetix\arm-elf\bin\arm-elf-gdb.exe”:

Create, manage, and run configurations

PN —*l
= o
LT = % | E Marne: IBasicMMU

L filer ket
I [ ﬂ Comrmands | 'Egy Su:uuru:e| = Q:ummu:un| N

----- [c] cfC++ Attach to Loce
----- E Z/iZ++ Local Applicati Debugger: IEmI:ueu:Iu:Ieu:I G0 j W Stop on startup at:  Advanced..
----- ] C/C++ Pastmartem d -
----- & Eclipse Application

—Debugger Options

----- 5 Embedded debug (Cy Main |
_ Embedded debug {Mal
LS BasichMMU GDE debugger: In'l,arm-,EIF-ng:u.exe Browse, ..

""" ‘53‘ Equinoe O50Gi Framew
_____ = J:va Applet GDE command File; |

----- 31 Java Application fWarning: Some commands in this file may interfere with the skartup
_____ Ju Uit operation af the debugger, For example "run®.

""" nﬁ:" JUnit Plug-in Test GDE cammand sek: IStanu:Iaru:I VI

""" E Remote Java Applicat
""" | ST Application Prokocal: m o

Browse, .,

il

—

‘I I LI apply | Revett |
(7) Debug I Close |
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Now change to the Commands tab and enter these commands considering your PEEDI IP address:

Create, manage, and run configurations

-+
ST

E C/iZ++ Attach to Local Applic
E C/iZ++ Local Application

E Z/iZ++ Postmorkem debugge
4 Eclipse Application

3¢ Embedded debug {Cygwin)
Embedded debug (Mative)
F(; BasichrU

4 Equinox O5GI Framewark

0] 2ava spplet

31 Java Application

Ju JUnik

JU Uit Plug-in Test

E Remote Java Application

[

Mame: | BasicrMmMU

xD Main| ff‘r Debugger m\ﬁ// SDLIrEE| =] Comman |-‘

Tnitialize' commands

target remote 192,165, 3.56:2000

sef remate memary-wiite-packet-size fixed
set remote memary-write-packet-size 16354
set download-write-size 16128

set $cpsr=0x03

load

=

[~
[—

'Run’ commands

7] swT application

appl Reyert
F I I _’I PRI | il |
(7) Debug I Close

These command will tell gdb:

- to connect to your PEEDI

- to use big blocks for memory load, t
- to set the CPU CPSR register so all
- to load the project executable file to

Next clock Apply and Debug, this will

& Confirm Perspective

2)

suspends,

This Debug perspective is designed to support application debugging. It
incorporates views For displaving the debug stack, variables and breakpaink

managementk.

Do wou wank ko open this perspective nows

¥ Remember my decision

This kind of launch is configured ko open the Debug perspective when it

his speeds up the transfer
interrupts are disabled
the target

start the debugger and Eclipse will ask you:

Switch
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Working with Eclipse

Check remember my decision and click YES.

Now the debugger is started:

_lolx|
File Edit Refactor Mawvigate Search Project Run window  Help
| i = e |3 -0 -Q- | ®® 4 | g el | %5 Debug ?
#CEFDehug ey Yariables (ee Ereakpoints &% REgistErs|MnduIas| = =
L S e |2 = #® -n|mEg|nT
= BasickMU [Embedded debug {Mative)]
@ Embedded GDE (06-11-28 13:30) {Suspended)
=g Thread [0] (Suspended)
= 1 <symbal is nat availahle s DxfFFFFFFc
+| Ci\Program Files\Ronetiarm-elfibintarm-slf-gdb. exe (06-11-28 13:30)
B CiiProgram Files\Ronetixiexamples|at91same261pm926 1 BasicMMUBasick MU, elf
< | i
M\ = 0| 5% outire &2 Disassembly| =0
int wain(void) - 1% 8 s 0 ¥

i
void (*pDhrystone) (void] = (void (*) (void)) [ {unsigmed int)
ATS1F_DBGU_Printk(["-I- Enter in main() section\n\r");

AT91F Dhryston

AT91F _DBGU Printk("-I- no MMO,
ATS1F DissblelICache();

ATS91F DissbkleDCache();

ATS1F Dhrystone();

I+D Caches Disabledinir™):

AT91F_DBGU_Printk("™in\r-I- no MMU, I Cache Enabledinir"):
AT91F _EnshlelCache (] :
AT91F_Dhrystone();

«| |

skdio.hy
ATI15AMI2E1.h
lib_aT9154M3261.h
mrmh
TTE_EMTRIES_MUM
ttb_array
ATS1F_DBGLI_Printk,
testloap
AT91F_Dhrystone
ATI1F_InitMru
main

El consale 22 Tasks | Mermory |

BasicMMU [Embedded debug (Mative)] :\Program Files\Ronetixlexamplesiatd1 sam9261pme26 1\ BasictMULBasicMMU. elf (06-11-28 13:30)

=

K1, s

J " Wirikable Smart Insert | 1:1 J J [ = | 3@ e l
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Set a break point on the first code line of the main function by double clocking the grey margin:

& Debug - se SDK ]
File Edit Refactor Mawvigate Search Project Run window  Help

JL=:" ‘-"‘WJ%'D'%'JB@Q’V‘J- = i Ef?t&Dabug »
%5 Debug 52 Variables (ee Breakpoints &5 . Registers | Mmdulas| = [l

XRFBEw | maE|n~

~[#] @ Ct\Proaram Files\Ronetixiexamplesiatal sam92611pmo261 | BasicMMUYsrcimain. ¢ [lim

BasickMU [Embedded debug {Mative)]
=-6# Embedded GDE (06-11-28 13:30) (Suspended)
Euj@ Thread [0] (Suspended)
= 1 <symbal is nat availahle s DxfFFFFFFc
B CiProgram FilesiRonetixiarm-glfibinarm-elf-gdb.exe (06-11-28 13:30)
“epi] CHiProgram Files\Ronetixiexamples!atd 1sam9261pm226 1 BasicMMU BasictMU, elf

o | [T L
M\ = m EE Qutlineg £ Disassembly| =0
int wain(veid) = BB e
{ o S tdin.
v void (*pDhrystone) (void) = (void (*) (void)) ((unsigned int) ATS1F Dhryston o | ATO154MaZE1.h
ATS1F_DBGU_Printk(["-I- Enter in main() section\n\r"); b aT9154M9261.h
e !

) ) mrmh
ATS1F_DBGU_Printk(["-T- no MMI, I+D Caches Disabledinir"): #  TTB_ENTRIES_MUM
ATS1F_DisableICache(): @5 up _array B
ATS1F_DisshleDCache(]: ¥ ATSLF_DBGU_Printk
ATS1F Dhrystone(); H test\on; h

) o @ AT91F_Dhrystone
AT91F_DBGU_Printk("™in\r-I- no MMU, I Cache Enabledinir"): @  AT9IF InithMMU
AT91F _EnshlelCache (] : J @ main -

ATI1F Dhrystone();
= -
| | p

El Console 52 Tasks|MemDry| | Ent 5§| BT -5 0
BasicMMU [Embedded debug (Mative)] :\Program Files\Ronetixlexamplesiatd1 sam9261pme26 1\ BasictMULBasicMMU. elf (06-11-28 13:30)

=
L] LlJ
J 0= | Witikable | Smatt, Insert | 1:1 J J [ B | J F e l
Next click the Resume botton. The application is started and shortly it should break were the break
point is:
c - Eclipse SDK i =] |
File Edit Refackor MNavigate Search Project Run  Window Help
[ i = | |3 - O - @@ | o S R [ | #FDebug >
% Debug 52 = O ||variables (ee Breakpoints &3 Registers|ModuIas| = [l
Lo e e i = s o RRF AN BEE| 2T
= BasicMMU [Embedded debug {Mative)] - [#] @ C:\Program FilesiRonetix\examplesiatolsam9261pmI261 | BasicMMUYsrcimain.c [lind

& @ Embedded GDE (06-11-25 13:39) {Suspended)
=g Thread [0] (Suspended)
-+= 1 main(} at C:{Program Files\Ronetixiexamples|atdlsamd261ipmaz6 1\ Basic
B CtYProgram Files\Ronetix\arm-glF\bin} arm-elf-gdb. exe (06-11-28 13:39)
] Ci\Program Files\Ronetixiexamples)at?1sam926 1 pma26 1 BasicMMU BasicMMU, elf

4| | il | |
[ main.c 22 = O || outline ( Disassembly &3 =0
} -] { -
Ox0Z000d28 <mains: str
Ox02000d2Zc <maintds: sub
int main(wvoid) wvoid [*pDhrystone) (void)
{ BO0x02000430 <wain+8s: 1dr
¥ void (*pDhrystone) (void] = (void (%) (void)) [iunsigned int] AT91F Dhryst Ox02000d534 <main+lzr: add
AT21F_DBGU Printk("-I- Enter in main({] sectioninir"): 0Ox02000435 <main+ler: Str
AT91F_DEGU Printk("-I- E
AT91F_DEGU_Printk("-I- no MHMU, I+D Caches Disabledinic"); Ox02000d3c <main+20>: 1dr
ATS1F_DissblelCache() Ox02000d40 <main+Zds>: bl
AT91F DissbleDCache();
ATS1F Dhrystone(): J AT91F_DEGU Printk("-I- &

0x02000d44 <maint2s>: ldr
ATS1F DBEGU Printk(™\n\r-I- no MMU, I Cache Enabledinir"; _IL| m-In'JnnnrmIR cmEin+IPee Rl _l;|
» 4 »

B3|t B -r5-20

| =

" o]
Iy | [0 = ® |
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Working with Eclipse

At this point you can continue debugging, i.e. step, put breaks, resume, etc.

5.3 Using Insight debugger as an Eclipse external tool

| you prefer you can use Insight for a debugger when developing with Eclipse IDE.
For this reason you need to add it as an external tool by clicking Run->External Tools->External
Tool...

rch Project | Run Window  Help

@ - A% = % Run Last Launched Chrl+F11 @ {);' J - J =
= %, Debug Lask Launched  F11
=)
Run Hiskary L4
= £
E‘L Run As 3
Run...
Debug Hiskory L4
Debug As »
Debug, ..

¥L External Tools Run As d

. External Toals...

Organize Favorites. ..

In the “External Tools” dialog select Program and click the New button:

& External Tools
Create, manage, and run configurations
Run a program
=
| = Caonfiqure launch settings from this dialog:
I type filter text “ - Press the Mew' butkon to create a configuration of the selecked bype,
" & Aot Build {=| - Press the 'Duplicate’ button to copy the selected configuration.
a
¥ - Press the 'Delete’ button bo remove the selected configuration.
::: - Press the 'Filter' butkon to configure Filkering options.
- Edit or view an existing configuration by selecting it.
Configure launch perspective setkings From the Perspectives preference page,
(7) B Close
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Working with Eclipse
In the new dialog for name type “Insight”, for location click Browse and navigate to “Ronetix\arm-

elf\bin\arm-elf-insight.exe”, for Working Directory click Browse Workspace and select BasicMMU and
for Arguments type BasicMMU.elf.

& External Tools

X
Create, manage, and run configurations Q
R i,
UM & prograr
prog =l

& =

T E % | = Parme: IInsight
I bvpe filker bext

m\_@h ReFresh| =} Environment| E=| Q:nmmu:nn|

-5 Ak Build :

i —Location:
El--% Prograrm

----- % Mew_configt

| Z:\Program Files\Ronetixharm-elfibint arm-elf-insight, exe

Browse Workspace. .. | Browse File System. .. | Variables. .. |

—orking Directory:

| ${workspace_loc: /BasicMrML}

Browse Workspace. .. | Browse File System, .. | Variables. .. |

—arguments:

BasicMMLI, elf

Variables. .. |

|_Moke: Enclose an argument containing spaces using double-quaotes (7,

Apply | Rewvert |
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Working with Eclipse

Now click on Common, and in the “Display in favorites menu” select Insight to add it to the Run menu
and click Apply and Close:

& External Tools |
Create, manage, and run configurations 0
R al—.
un a prodrarm
e Ty
= =
=% | = Marme: IInsight
I tvpe filker bext
KE| Main | t;rﬁh Refresh | E Environment m
3 ant Build -
E% Program 2as a3
- & Local file
----- % Mew_configt
™ Shared File: | Browse, .. |
—Display in Favorites menu—————— — Consaole Encoding
I% * Default {Cpl251)
" Other |150-5359-1 |
—Standard Input and Cukput
¥ Alocate Console (necessary For input)
™ File: |
Browse Warkspace... |  Browse File System. .. Wariables, ..
™| append
W Launch in background
appl R k
q o PRl | e |
@) Bun Close |

Now you have Insight in your Run menu.
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Working with Eclipse

=t | Run  Window  Help

4 4 O Run Last Launched w4Fll o |- | o -
E«, e, Debug Last Launched Fi1
= | Run Hiskary >
L Run As 4
Rur...
Debug History L
Debug As »
Debug...

'= External Tools "= 1 Insight

Run As L4
% External Tools, ..
Organize Favoaorites. .,

You have just added the Insight.

You can follow the previous procedure to add any external tool you wish to use while developing.
Now you can start Insight and debug the project.
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